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Self-transition Guide for Office Live Small Business 

Customers 

Introduction  
Microsoft is excited to bring our Office Live Small Business customers Microsoft Office 365, the next generation of 

online productivity tools.  This document is intended to help our Office Live Small Business customers through the 

steps of moving manually moving their data to Office 365. 

Important Information Before Transitioning 

Please read the following important information before you begin the transfer steps: 

Important Information 

 This document is designed for customers choosing to self-transition from Office Live Small Business 

(OLSB) to Office 365 for professionals and small businesses.   

 Follow the steps in this guide in order to minimize the chance of losing data. 

 OLSB account data not saved or transferred will be inaccessible after May 1, 2012 or after your account is 

canceled.  This includes email, contacts, calendar, business application data, site analytics, contact 

manager and your public facing website. 

 Some limitations apply during the Office 365 free-6 month trial period, including: you can only add 25 

users.  

 If you are transferring a custom domain, there may be a period of between 24-72 hours when you will not 

be able to receive email. 

 Your fourth-level domain (yourdomain.web.officelive.com) cannot be transferred. 

 Review Appendix B: Office 365 System Requirements 

Help Resources 

The instructions below provide the basic step-by-step procedures for moving your OLSB account to Office 365 for 

small businesses and professionals. If you want more information or have questions, we encourage you to consult 

the help resources available for OLSB and Office 365.   

Office Live Small 

Business Community 

Your primary resource for transition-related help.  Contains forums (monitored by 

members of the Office Live Small Business Support team) where you can ask and 

http://g.microsoftonline.com/0bd00en-us/576
http://g.microsoftonline.com/0bd00en-us/576


  
 

   

Self-transition guide for Office Live Small Business Customers | 2 

receive answers to your questions and read the latest Office Live Small Business 

information. 

Office 365 Help  Help and how-to information for Office 365. 

Office 365 Quick Start 

Guide  

Get started with mail, contacts, calendar, instant messaging, and document sharing. 

Introduction for Office 

365 Administrators  

Get started with service administration and user management tasks. 

Office 365 Community  Contains forums (monitored by members of the Office 365 Support team) where you 

can ask and receive answers to your questions, report service issues, bugs, make 

suggestions, and read the Office 365 blog and wiki.  

Office 365 

Marketplace 

Search, find and hire a partner that can help with the transition to Office 365.  

What you will need  

 As a part of the exclusive offer for OLSB customers – you are provided a copy of Office Professional Plus 

which provides you the latest Office 2010 desktop applications  during the 6 month trial period. If you 

choose not to accept the promotional offer, each person on your account will need a copy of Microsoft 

Office Outlook 2007 or Outlook 2010 if they want to move their email, contacts and calendars. 

(Alternatively, you can archive your email, contact, and calendar data in the free Windows Live Mail 

software.) 

 Most of the transition steps can be performed by anyone with Administrator privileges, but certain steps 

can only be performed by the OLSB account owner. 

 Anyone who uses the OLSB account and wants to move their personal email, contacts, calendar and 

documents will need to perform some tasks. 

 The transition steps may take between 2-6 hours per user.  The actual amount of time required will vary 

depending on the number of users and the amount of data being transitioned. The process will involve 

manually re-building your public-facing website.  

 We recommend that you build a mini-project plan to ensure that all of the tasks are completed by the 

April 30, 2012 deadline date.  

If you don’t want to use Office 365, you have other options 

 

http://g.microsoftonline.com/0BD00en-US/59
http://g.microsoftonline.com/0BD00en-US/135
http://g.microsoftonline.com/0BD00en-US/135
http://g.microsoftonline.com/0bd00en-us/137
http://g.microsoftonline.com/0bd00en-us/137
http://g.microsoftonline.com/0BD00en-US/217
http://g.microsoftonline.com/0rmcm00en-us/5222
http://g.microsoftonline.com/0rmcm00en-us/5222
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OLSB appealed to a lot of different people, especially because of the free website.  Office 365 is targeted at 

meeting the needs of small business owners and professionals. Many OLSB customers won’t see Office 365 as a 

good fit, especially since Office 365 isn’t free.  

 

If you: 

 Are a small business owner or professional, then you may want to evaluate Office 365, especially since 

OLSB customers get a 6-month free trial. 

 No longer use your website, you can let it be deleted on April 30, 2012. Check the section below for 

advice on saving your data (like documents and photos), so that you don’t lose something important. 

 Use a custom domain (like contoso.com or fourthcoffee.com) for your email and website, then you need 

to move that domain off of OLSB and onto a new provider. You can choose Office 365 or any other 

provider you want. 

 Want a free way to share information with people, then there are other services that might work better 

for you than Office 365.  

 

If you want to… Possible services to consider 

Share photos and videos with family and friends          Windows Live SkyDrive lets you share 

photos and control who can see them 

         Photo Gallery lets you store, share, and edit 

photos and videos 

         You can also search the Web for “photo 

sharing sites” to evaluate the options and decide 

what is right for you. 

Publish text information, like descriptions of travel, 

hobbies, opinions, and what is happening in your 

life 

         Consider creating a blog.  

         Windows Live Writer is a free tool that 

makes it easy to write and publish your blog, no 

matter where your blog is hosted. 

         You can also search the Web for “free blog” 

to evaluate the options and decide what is right for 

you. 

Share files with people you know          Windows Live SkyDrive lets you share 

documents and control who can see them 

  

Collaborate and share Office documents online          Office Web Apps let you access, edit, and 

share Word, Excel, PowerPoint, and OneNote 

documents on the web 

  

Don’t lose your email, website, documents, and photos! 

No matter which option you choose, please save your data. You won’t be able to get it back after OLSB is shut 

down. 

 

Your email 

 If your email address ends with @live.com, @hotmail.com, or @msn.com, it will not be deleted. You 

will still be able to use Windows Live to access, send, and receive email. 

 If you have an email address based on a custom domain (such as joe@fourthcoffee.com or 

susan@contoso.com), then you must move your domain from OLSB to Melbourne IT or another domain 

registrar. If you don’t move your domain, you will lose access to all of your email at that address. 

 Your website  

http://www.office365.com/
http://explore.live.com/skydrive
http://explore.live.com/windows-live-essentials-photo-gallery-get-started
http://www.bing.com/
http://explore.live.com/windows-live-essentials-other-programs?T1=t5
http://www.bing.com/
http://explore.live.com/skydrive
http://office.microsoft.com/en-us/web-apps
http://www.windowslive.com/
mailto:joe@fourthcoffee.com
mailto:susan@contoso.com
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 If your website uses a custom domain (such as www.fourthcoffee.com or www.contoso.com), then you 

must move your domain from OLSB to Melbourne IT or another domain registrar. If you don’t move 

your domain, no one will be able to access your website. 

 You can save your website pages to your computer. There are a variety of third party tools that can 

help save the content on your OLSB website, such as Inspyder’s Web2disk, Website downloader, or 

HTTrack.  These are third party services that are unaffiliated with Microsoft. You will need to investigate 

whether their services will meet your particular needs.  Microsoft is not responsible for these third 

party services. 

 You can save your website statistics to your computer. At the top of the page in OLSB, click More > 

Reports > Download reports, and then follow the instructions. 

 If you don’t need your website anymore, you don’t have to do anything. It will be deleted on April 30, 

2012. 

 If you purchased a domain through OLSB and don’t need it anymore, you can let it lapse. When 

Melbourne IT asks if you want to renew your domain, you can say no. 

 

Your documents and photos 

 If you want to save your photos, go to Design Site > Image Gallery, right-click each image, and select 

Save Picture As to save it to your computer.  

 If you want to save your documents, go to Design Site > Document Gallery, open each document, 

and then save it to your computer. 

 There are a variety of third party tools that can help save the photos and documents on your OLSB 

website, such as Inspyder’s Web2disk, Website downloader, or HTTrack.  These are third party services 

that are unaffiliated with Microsoft. You will need to investigate whether their services will meet your 

particular needs.  Microsoft is not responsible for these third party services 

 If you don’t need your documents and photos anymore, you don’t have to do anything. They will be 

deleted on April 30, 2012. 

 

Your domain 

 If your website uses a custom domain (such as www.fourthcoffee.com or www.contoso.com), then you 

must move your domain from OLSB to Melbourne IT or another domain registrar. If you don’t move your 

domain, no one will be able to access your website. 

 If you have an email address based on a custom domain (such as joe@fourthcoffee.com or 

susan@contoso.com), then you must move your domain from OLSB to Melbourne IT or another domain 

registrar. If you don’t move your domain, you will lose access to all of your email at that address. 

 

Overview of the transition steps 

To help ensure that you transfer your Office Live Small Business account without losing data, it’s important that 

you complete the following steps in order: 

1. Create your Office 365 account 

2. Move all email, contacts, and calendars 

3. Move your website to Office 365 and save your business applications 

4. Move your custom domain (if you have one) and create users in Office 365 

 

http://www.fourthcoffee.com/
http://www.contoso.com/
http://www.inspyder.com/products/Web2Disk/Default.aspx
http://www.web-site-downloader.com/entire/
http://www.httrack.com/
http://www.inspyder.com/products/Web2Disk/Default.aspx
http://www.web-site-downloader.com/entire/
http://www.httrack.com/
http://www.fourthcoffee.com/
http://www.contoso.com/
mailto:joe@fourthcoffee.com
mailto:susan@contoso.com
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Step 1: Create your Office 365 account 

To retrieve your one-time use promotional code to create your Office 365 account, sign in to your OLSB account 

with the owner account Windows Live ID and click on the promotional code link. This link will open a new browser 

window on Office 365 to a unique sign up form that includes Office 365 for professionals and small business and 

Office Professional Plus.  Follow the instructions to complete sign up for the 6-month free trial promotional offer. 

Only the account owner needs to sign up. For now, the owner will also be the account administrator, and will add 

the rest of the organization’s people and data.  

If you choose to close the promotional offer page, you can get access to the promotional offer until April 30, 2012 

by signing in to OLSB.   

I signed in to OLSB, but I don’t see the link  
You might have signed in with a different account. The migration notice and free trial link only show up for the 

owner’s account.  

• If you aren’t the owner, find the owner and ask them to sign in. 

• If you are the owner, check if you used a different Windows Live ID than you did when you set 

up your account. If you can’t remember your original Windows Live ID, contact Support. 

Consider hiring someone to move your data for you 

It will take time and work to move your email and website to Office 365. The process includes a lot of steps and 

many technical terms that you might not be familiar with.  

Many people prefer hire an approved Microsoft partner to transition their accounts to Office 365 instead of doing 

it themselves. You can evaluate potential partners on the Office 365 Marketplace. If you do hire someone, you can 

work with them to move your email and website, instead of following the instructions in this document. 

These instructions apply only to organizations that create accounts for Office 365 for professionals and small 

business. If you have more than 25 people or require technical phone support, you may want to consider Office 

365 for enterprises. 

 

Step 2: Move all email, contacts, and calendars 

As part of the exclusive free trial for OLSB customers, you get Office Professional Plus, which includes Outlook 

2010. One reason this is included is because Outlook is the easiest way to get your mail, contacts, and calendar 

items from OLSB into Office 365.  

Notes:  

 Although most of the steps in this guide are only done by one person for the whole company, each 

person at your company will need to save and move their email, contacts, and calendar items. 

 If you don’t want to use Outlook, you can also use Windows Live Mail to save your mail and other items to 

your computer. Then you can copy the items to your Office 365 account.  

https://support.smallbusiness.officelive.com/default.aspx?productkey=olsmb
http://g.microsoftonline.com/0rmcm00en-us/5222
http://explore.live.com/windows-live-essentials-other-programs?T1=t2


  
 

   

Self-transition guide for Office Live Small Business Customers | 6 

Warning: Every person in your organization must follow this step and move their email, contacts, and calendars, 

or this data will be lost in Step 4: Move your custom domain, below. 

1. Open Outlook.  

2. If the Microsoft Outlook Startup wizard displays automatically, follow the instructions to set up an e-mail 

account.  

If the Microsoft Outlook Startup wizard doesn't display, on the Outlook toolbar, click the File tab. Then, 

just above the Account Settings button, click Add Account.  

3. On the Auto Account Setup page of the wizard, when you click Next, Outlook will perform an online 

search to find your e-mail server settings. You'll be asked to enter your user name and password during 

this search. Make sure that you enter your full e-mail address (for example, tony@contoso.com) as your 

user name. If Outlook is able to set up your account, you'll see the following text: Your e-mail account is 

successfully configured. Click Finish. Tip: If Outlook isn't able to set up your account, see Set Up E-Mail in 

Outlook 2010 at http://help.outlook.com/en-us/140/dd253202.aspx. 

4. In Outlook, in the Mail section of the left navigation pane, locate your Office 365 mailbox.  

5. In Outlook, in the Mail section of the left navigation pane open your Office Live Small Business mailbox 

that you just added. Open one of the folders, for example the Inbox folder.  

6. Select all of the email messages in that folder, copy them, and then paste them into the corresponding 

folder in your Office 365 mailbox. (If you don’t have a corresponding folder in your Office 365 mailbox, 

you may have to create one.) Now this email has been added to Office 365. Repeat this for every folder in 

your Office Live Small Business email account.  

7. Repeat these steps for the Contacts folder and the Calendars folder. If you can’t select all items in a folder, 

you can copy them individually. 

For other questions, see FAQs: E-Mail Programs at http://help.outlook.com/en-us/140/cc875919.aspx.  

 

If Outlook isn't able to set up your account, see Set Up E-Mail in Outlook 2010 at http://help.outlook.com/en-

us/140/dd253202.aspx. 

 

Continue to use Windows Live (Hotmail) for your email 

If your email address ends with @live.com, @hotmail.com, or @msn.com, it will not be deleted. You will still 

be able to use Windows Live (Hotmail) to access, send, and receive email. 

 

If you have an email address based on a custom domain (such as joe@fourthcoffee.com or 

susan@contoso.com), but you don’t need your domain for a website, you can use Windows Live Admin Center to 

manage email accounts at your domain.  

mailto:tony@contoso.com
http://help.outlook.com/en-us/140/dd253202.aspx
http://help.outlook.com/en-us/140/dd253202.aspx
http://help.outlook.com/en-us/140/dd253202.aspx
http://help.outlook.com/en-us/140/cc875919.aspx
http://help.outlook.com/en-us/140/cc875919.aspx
http://help.outlook.com/en-us/140/dd253202.aspx
http://help.outlook.com/en-us/140/dd253202.aspx
http://help.outlook.com/en-us/140/dd253202.aspx
http://www.windowslive.com/
mailto:joe@fourthcoffee.com
mailto:susan@contoso.com
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To do this: 

1. Save your email to your computer and have each person in your company save theirs. 

a) Install Windows Live Mail from Windows Live Essentials. It’s free.  

b) Follow the directions in Windows Live Mail to add your existing email account. 

c) Windows Live Mail will save copies of all your mail, contacts to your computer. 

d) Later, after you’ve moved your domain, you can continue to use Windows Live Mail, or use 

www.windowslive.com (Hotmail) like you are used to. 

 

More info about: 

 Windows Live Mail 

 Importing and exporting email, contacts, and calendars 

 

2. Contact OLSB Support. Say: 

I’ve already backed up my email and documents. Now I need my domain to be released from Office 

Live Small business.  

 My domain is: 

 My primary email address at that domain is: 

 An alternate email address that you can use to contact me is: 

3. A Support agent will notify you when your domain has been removed from OLSB. This usually takes 24 

business hours. If it takes longer, please contact OLSB Support to ask for status on the request. 

4. Go to Windows Live Admin Center. 

5. Click Sign up now—it’s free. 

6. Enter your domain name, select Set up Windows Live Hotmail for my domain, and then click Continue. 

7. Sign in with a Windows Live ID or create a new one. An email message will be sent to this address so that 

you can verify that it is yours. 

8. Follow the directions to finish setting up your account. 

9. After you have set up your account, go to the Domain settings page. Follow the directions to prove that 

you own the domain. (You can’t use Windows Live Admin Center to manage a domain unless you own it.) 

10. When the domain has been verified, the status on the Domain settings page will change from “Pending” 

to “Approved”. 

11. At this point, you can manage your email accounts in Windows Live Admin Center, and can use 

www.windowslive.com (Hotmail) to read your email. More information: 

http://explore.live.com/windows-live-essentials-other-programs?T1=t2
http://www.windowslive.com/
http://explore.live.com/windows-live-essentials-help-center?T1=t6
http://explore.live.com/windows-live-mail-import-backup-and-restore
https://support.smallbusiness.officelive.com/default.aspx?productkey=olsmb&st=1&wfxredirect=1
https://support.smallbusiness.officelive.com/default.aspx?productkey=olsmb&st=1&wfxredirect=1
http://explore.live.com/windows-live-admin-center
http://www.windowslive.com/
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 To create more accounts, see: Manage your e-mail accounts and users 

 For other questions, see: About Windows Live Admin Center 

12. Copy the email that you saved to your computer into your new Hotmail account. For more information, 

see Export from Windows Live Mail. 

 

Step 3: Move your website to Office 365 or another website hoster 

To transfer your OLSB website to Office 365, you need to manually move your content. For text, this is just a 

matter of copying from one site and pasting into the other, but for some images or for your site’s header, 

additional steps are required.  

These instructions offer a brief overview of how to transfer your website, but for more detailed explanations of 

how to use the Office 365 web-design tool, see the help topics contained in Design a public-facing website at 

http://office.microsoft.com/en-us/sharepoint-online-small-business-help/CL102040066.aspx. 

 

On April 30, 2012, all of your documents and data on OLSB will be deleted. If you don’t want to lose this data, save 

it before the deadline. 

 

Your website 

 You can save your website pages to your computer. There are a variety of third party tools that can 

help save the content on your OLSB website, such as Inspyder’s Web2disk, Website downloader, or 

HTTrack.  These are third party services that are unaffiliated with Microsoft. You will need to investigate 

whether their services will meet your particular needs.  Microsoft is not responsible for these third party 

services. 

 You can save your website statistics to your computer. At the top of the page in OLSB, click More > 

Reports > Download reports, and then follow the instructions. 

 

Your documents and photos 

 If you want to save your photos, go to Design Site > Image Gallery, right-click each image, and select 

Save Picture As to save it to your computer. 

 If you want to save your documents, go to Design Site > Document Gallery, open each document, 

and then save it to your computer. 

 If you don’t need your documents and photos anymore, you don’t have to do anything.  

 

Your business applications (like lists, calendars, and surveys) 

1. On the Office Live Small Business Home page, at the top, click More, and then click Business 

Applications.  

2. On the actions bar, click Actions, click Export to Spreadsheet, and then click Open. A spreadsheet opens.  

3. Under File, click Save As. Under Save as type, select CSV (MS-DOS).  

http://explore.live.com/domains/manage-your-e-mail-accounts-and-users
http://explore.live.com/domains/about-windows-live-admin-center?mkt=en-us
http://explore.live.com/windows-live-mail-import-backup-and-restore
http://office.microsoft.com/en-us/sharepoint-online-small-business-help/CL102040066.aspx
http://office.microsoft.com/en-us/sharepoint-online-small-business-help/CL102040066.aspx
http://www.inspyder.com/products/Web2Disk/Default.aspx
http://www.web-site-downloader.com/entire/
http://www.httrack.com/
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Your contacts in Contact Manager 

1. On the Office Live Small Business Home page, at the top, click More, and then click Contact Manager.  

2. On the left navigation bar, click Business Contacts, Companies, Opportunities, or Products.  

3. On the actions bar, click Actions, and then click Export to Spreadsheet, or click Open with Access, and 

then select Export a copy of the data. You may be prompted to sign in with your Windows Live ID.  

4. The list opens in a workbook or table. Save it to your computer. 

Note: Office 365 doesn’t have all of the same website features that OLSB did. These features are not available: 

Blog, Event Calendar, Form Designer, List Publisher, Subscribe to Newsletter, and website reports. 

 

Open the old web-design tool and the new web-design tool side-by-side 

The easiest way to transfer your website content is to open the OLSB web-design tool and the Office 365 web-

design tool side-by-side so that you can see them both at the same time. 

 

Open the OLSB web-design tool: 

1. On the OLSB Home page, at the top, click Web Site. Page Manager appears. 

2. In the list of Web pages, find the name of the page that you want to copy content from and click Edit. The 

page opens in the web-design tool. 

 

Open the Office 365 web-design tool: 

1. On the top-navigation in the Office 365 Home page, click Team Site. 

2. On the navigation bar, click Website. 

3. In the list of web pages, click the name of the page that corresponds to the page you are copying content 

from. For example, if you’re copying the Home page from your OLSB website, click Home. Now you’re 

seeing the Web page in edit mode. 

4. If you don’t see the kind of page that you need in the list of web pages, on the Pages tab, click New 

Page, select the type of page that you need, provide the necessary properties, and then click Finish. The 

page is now open in edit mode. 

Now that you have opened the two web-design tools, resize the two browser windows so that you can see them 

both at the same time, one on the left and one on the right. You’re ready to begin moving your website. 

 

Move content from your old site to your new site 

Follow the instructions above in Open the old web-design tool and the new web-design tool side-by-side. To 

move text or images from your old page to your new page, simply copy and paste it.  
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If an image fails to paste properly, you may have to add it using the Insert function: 

1. In the Office 365 web-design tool, click the Insert tab. 

2. Click Image. 

3. Select the location from which you want to add the image, click the image, and then click Insert image.  

 

Move your website header  

Follow the instructions above in Open the old web-design tool and the new web-design tool side-by-side.  

After you have opened the two web-design tools, click anywhere in the header of your two web pages, and the 

Customize your header dialog opens.  

To transfer text, just copy and paste. To transfer logo images, you must first save them to your computer and then 

upload them to your new site. To learn more about making changes to your header, see Customize a header for a 

public-facing website at 

http://office.microsoft.com/serverhelp/helppreview14.aspx?AssetId=HA101836349&lcid=1033&products=SPOLite

&pid=CL102040077&CTT=4. 

 

Add a module 

Unfortunately, you can’t copy modules—or “Gadgets,” as they’re now called—from your old site to your new site. 

You need to create a new version of that gadget on your new site. To do so, place your cursor at the location 

where you want to insert the gadget. On the Insert tab, in the Gadgets section, click the gadget that you want to 

insert, and then follow the instructions.  

Note: The following gadgets are unfortunately not available in Office 365 at this time: Blog, Event Calendar, Form 

Designer, List Publisher, and Subscribe to Newsletter. Website analytics are also not available at this time. 

 

 

Step 4: Move your custom domain 

Moving your custom domain name involves several steps. First, you remove your custom domain name from 

OLSB. Next, add your domain to Office 365 or another website hosting provider and verify that you own the 

domain. Finally,  update the records at your domain registrar to direct network traffic for your domain to Office 

365 or the other website hosting provider. Watch a video that shows how to remove a domain and add it to Office 

365:  http://youtu.be/GBWTwOQ2F5o.   

 

Remove your domain name from your OLSB account 

http://office.microsoft.com/serverhelp/helppreview14.aspx?AssetId=HA101836349&lcid=1033&products=SPOLite&pid=CL102040077&CTT=4
http://office.microsoft.com/serverhelp/helppreview14.aspx?AssetId=HA101836349&lcid=1033&products=SPOLite&pid=CL102040077&CTT=4
http://office.microsoft.com/serverhelp/helppreview14.aspx?AssetId=HA101836349&lcid=1033&products=SPOLite&pid=CL102040077&CTT=4
http://office.microsoft.com/serverhelp/helppreview14.aspx?AssetId=HA101836349&lcid=1033&products=SPOLite&pid=CL102040077&CTT=4
http://youtu.be/GBWTwOQ2F5o
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In order to free up your domain name for use with Office 365 (or another provider,) you must remove it from 

OLSB.  

 

 If you bought your custom domain through OLSB, we provide you with a way to move your domain.    

Caution: Before you move your domain, we recommend updating your administrator email address to 

an address not associated with your Office Live Small Business account.  This will ensure that your 

Domain Registration Key (DRK) is sent to an active email address.  (For example, you can use a free 

Hotmail account).   

To update your administrator email address: 

1. On the OLSB Home page, at the top, click More, and then click Domain Manager. 

2. On the Domain Manager page, next to the domain name that you want to view, click Properties. 

3. On the Domain Properties page, you can make changes to your email address. Click Edit properties in the 

Registration Contact Information section and update your email address. 

To move your domain: 

1. On the OLSB Home page, at the top, click More, and then click Domain Manager. 

2. In the domains table, find your purchased domain and in the options column click Move domain. 

3. On the subsequent page, enter an email address to receive your domain registration key. If you don’t 

enter a valid email address, you won’t get the instructions you need in the next step. 

4. You’ll receive an email with full instruction with how to access your domain at Melbourne IT. 

Once you’ve clicked through the link in the email and completed the steps to access your domain at 

Melbourne IT follow the steps below to activate DNS. These steps are necesarry to enable you to 

perform the steps for adding your domain to Office 365 discussed in the next section. 

5. Sign in to your Melbourne IT account. If you have problems, use the phone number in the message to 

contact Melbourne IT. You will receive a bill from Melbourne IT every year that they host your domain. 

 

Activate DNS with Melbourne IT 

 

1. Create a new account on Melbourne IT or Sign in if you already have one 

2. In the Manage Domain Names section, Click Manage Domain Names. 

3. Click the domain name you moved to Melbourne IT. 

4. In the DNS section, next to DNS Status, click Activate DNS. 

5. Select the checkbox to indicate that you agree to Melbourne IT’s terms and conditions and click Enable 

DNS. 

6. Click  Manage Domain Names. 

7. Click your domain name again. 
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8. In the DNS section, click Manage DNS. 

9. Click on Redelegate Now. 

10. You are now ready to perform the steps for adding your domain and users to Office 365. 

 

Note that at this point your email will no longer be going to Hotmail, so you should complete the steps for adding 

your domain to Office 365 quickly. 

 

Once you’ve completed these steps, Office Live will continue to host your site pages and you can still access your 

OLSB email.   You will now have access to your domain at Melbourne IT and will be able to complete the steps 

necessary to add and verify your domain in Office 365. 

 

 If you bought your custom domain through another domain name registrar, you do not need to remove 

your domain from your account.   You have access to this domain at your domain hoster and will be able to 

complete the steps necessary to add and verify your domain in Office 365. 

 

Add your custom domain to Office 365 (for United States customers only) 

Note: If you are not located in the United States, follow the steps in the section “Add your custom domain to 

Office 365 (for customers outside of the United States)” 

To add your domain to Office 365, you step through the Add a domain wizard. The wizard verifies that you own 

the domain, and then prompts you to update your records at your domain registrar to direct network traffic for 

your domain to Office 365. 

1. In Office 365, on the Admin Overview page, in the left pane, under Management, click Domains, and then 

click Add a domain. 

2. On the first page of the wizard, type your domain. 

3. On the second page, when asked “Do people in your company already have domain.com email addresses?” 

answer yes or no. 

4. Also on the second page, when asked “Do you have a domain.com website?” answer No. You must 

answer no even though you have a website on OLSB. 

5. Follow the steps in the wizard to do these four important tasks: 

 Confirm that you own your domain (also called domain verification) 

 Update email addresses for people at your organization 

 Add user accounts to Office 365 
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 Complete the process so that email sent to your domain will be delivered to your accounts at 

Office 365 

 

Note: Typically it takes about 15 minutes for your changes to take effect. But it can take up to 72 hours for the 

DNS record that you created to propagate through the DNS system. If you need to view these record settings 

again, on the Domains page, click the domain, and then, on the Domain properties page, click the DNS manager 

tab. To check the status of configuring your domain in Office 365, on the Domains page, click the domain, 

and then, on the Domain properties page, click Troubleshoot domain. 

 

Add your custom domain to Office 365 (for customers outside of the United States) 

Note: If you are located in the United States, follow the steps in the section “Add your custom domain to Office 365 (United 

States customers only)” 

OLSB made it easy to get a domain, but OLSB isn’t actually a domain registrar. Behind the scenes, your domain 

registrar was really Melbourne IT.   

1. On the OLSB Home page, at the top, click More, and then click Domain Manager. 

2. In the domains table, find your purchased domain and in the options column click Move domain. 

3. On the next page, enter a current email address to receive your domain registration key. If you don’t enter 

a valid email address, you won’t get the instructions you need in the next step. 

4. You’ll receive an email with full instructions on how to access your domain at Melbourne IT. 

5. Open the email message from Melbourne IT. 

6. Click the link and follow the instructions to create your account with Melbourne IT.  

 If you have problems, use the phone number in the message to contact Melbourne IT.  

 You will receive a bill from Melbourne IT every year that they host your domain. 

 Unfortunately, Melbourne IT doesn’t support all kinds of domains. If your domain ends in .fr, .jp, 

or .de, please call Melbourne IT for your authorization code. With this you can transfer your 

domain to another domain registrar. The directions in this document focus on Melbourne IT, but 

you can add domains from any registrar to Office 365. Whenever this document refers to 

Melbourne IT, such as in step 7, you will need to follow directions from your domain registrar. 

Activate DNS with Melbourne IT 

 

1. Create a new account on Melbourne IT or Sign in if you already have one 

2. In the Manage Domain Names section, Click Manage Domain Names. 

3. Click the domain name you moved to Melbourne IT. 

4. In the DNS section, next to DNS Status, click Activate DNS. 

5. Select the checkbox to indicate that you agree to Melbourne IT’s terms and conditions and click 

Enable DNS. 

http://www.melbourneit.com.au/contacts/index
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6. Click  Manage Domain Names. 

7. Click your domain name again. 

8. In the DNS section, click Manage DNS. 

9. Click on Redelegate Now. 

10. You are now ready to perform the steps for adding your domain and users to Office 365. 

 

Add your domain to Office 365 and update name server records 

When you change your domain’s name server records in this step, you change the destination of domain services, 

such as email, to point to Office 365. Make sure that you have already completed the steps to create user 

accounts and re-create your website before you continue.  

1. Sign in to Office 365 (http://portal.microsoftonline.com) using the account you created.  

2. In Office 365, at the top of the page, click Admin. 

3. On the Admin Overview page, in the left pane, under Management, click Domains, and then click Add a 

domain. 

4. On the Add a domain page, under Specify domain, type the domain name that you just moved to 

Melbourne IT, and then click Next. 

5. Follow the steps in the wizard to verify with Office 365 that the domain name you have added belongs to you.  

6. After your domain is verified, you will see a page called Change Name Server Records.  

7. Select Melbourne IT in the dropdown. 

8. Follow the steps provided on the page to update your name server records.  

 

Change the SharePoint site address to use your domain 

Note: Your website will be unavailable on the Internet until you follow these steps to change the address in Office 365. 

1. On the Admin Overview page and click Domains.  

2. Above the list of domains, next to Your SharePoint website address is, click Change address. Follow the 

directions to use your domain for your website. 

 

For a complete overview of this process, we highly recommend that you read Add your domain to Office 365 at 

http://onlinehelp.microsoft.com/en-us/office365-smallbusinesses/ff637561.aspx#bkmk_provider.  

  

For other domain registrars other than Melbourne IT 

http://portal.microsoftonline.com/
http://onlinehelp.microsoft.com/en-us/office365-smallbusinesses/ff637561.aspx#bkmk_provider
http://onlinehelp.microsoft.com/en-us/office365-smallbusinesses/ff637561.aspx#bkmk_provider. 

http://onlinehelp.microsoft.com/en-us/office365-smallbusinesses/ff637561.aspx#bkmk_provider. 
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We provide specific instructions for changing the name server records on popular domain registrar 

websites. For more information, see Change name server records at a domain registrar at 

http://onlinehelp.microsoft.com/en-us/office365-smallbusinesses/gg549203.aspx.  

In general, to change your domain’s name server records, follow these steps.  

1. Sign in to your domain name registrar's website.  

2. On the domain registrar's website, locate the section where you can change name server sett ings. 

This section is typically labeled in one of the following ways:  

 Manage Domain 

 Nameserver Settings 

 DNS Server Settings 

3. On the page where you can change name server settings, edit the primary and secondary name 

servers to be ns1.bdm.microsoftonline.com and ns2.bdm.microsoftonline.com, respectively, 

and then save the new settings. 

Note: Typically it takes about 15 minutes for your changes to take effect. But it can take up to 72 hours 

for the DNS record that you created to propagate through the DNS system. If you need to view these 

record settings again, on the Domains page, click the domain, and then, on the Domain properties page, 

click the DNS manager tab. 

To check the status of configuring your domain in Office 365, on the Domains page, click the domain, 

and then, on the Domain properties page, click Troubleshoot domain. 

If you bought your domain through OLSB and want to move it to a different 
domain registrar 
 

OLSB made it easy to get a domain, but OLSB isn’t actually a domain registrar. Behind the scenes, your domain 

registrar was really Melbourne IT.  

 

You can switch to a different domain registrar: 

On the OLSB Home page, at the top, click More, and then click Domain Manager. 

In the domains table, find your purchased domain and in the options column click Move domain. 

On the next page, enter an email address to receive your domain registration key. 

You’ll receive an email with full instructions on how to access your domain at Melbourne IT. 

Open the email message from Melbourne IT. 

Click the link and follow the instructions to create your account at Melbourne IT. If you have problems, use the 

phone number in the message to contact Melbourne IT directly. 

http://onlinehelp.microsoft.com/en-us/office365-smallbusinesses/gg549203.aspx
http://onlinehelp.microsoft.com/en-us/office365-smallbusinesses/gg549203.aspx
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Once you have signed in to your account, you can access information about your domain. Copy this information 

and use it to transfer your domain to a new registrar. Each domain registrar has different instructions for this; look 

for instructions on your registrar’s site. 

 

Congratulations 

You have now completed the self-transition steps.  If you run into any problems, please contact: 

 OLSB support 

 Melbourne IT support for issues with domains 

 Office 365 community support 

See the Office 365 Quick Start Guide to get started with email, contacts, calendar, instant messaging, and 

document sharing.   

To get started with service administration and user management tasks, see the Introduction for Office 365 

Administrators.  To ask and receive answers to your questions, report service issues, bugs, make 

suggestions, and read the Office 365 blog and wiki, see the Office 365 Community. 

 

https://support.smallbusiness.officelive.com/default.aspx?productkey=olsmb&st=1&wfxredirect=1
http://www.melbourneit.com.au/contacts/index
http://community.office365.com/en-us/default.aspx
http://g.microsoftonline.com/0BD00en-US/135
http://g.microsoftonline.com/0bd00en-us/137
http://g.microsoftonline.com/0bd00en-us/137
http://g.microsoftonline.com/0BD00en-US/217
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What is Office 365? 
Office 365 for professionals and small businesses is a set of web-enabled tools that lets you access your e-mail, 

important documents, contacts, and calendars from virtually anywhere and on almost any device
1
. Designed for 

organizations with one to 25 employees (with a technical limit of 50 users maximum), the service brings together 

online versions of the best professional-grade communications and collaboration tools from Microsoft at a price 

that small businesses can afford.   Office 365 includes many of the features that our customers loved about Office 

Live Small Business, including simple public facing websites, and much more.   

Is Office 365 right for my business? 
Office 365 is designed for organizations with fewer than 25 employees and without IT staff, so it’s easy to set up 

and use.  Office Live Small Business customer feedback helped us design Office 365: professional email with anti-

spam/anti-virus protection and a 25GB mailbox, improved tools for document collaboration and version control, 

online meeting and IM capabilities, an improved mobile experience, simple public-facing website tools and 

hosting, and financially-backed reliability and security, all at a price affordable for most small businesses..   

How does Office Live Small Business compare to Office 

365? 
The best way to experience the difference between Office Live Small Business and Office 365 is by signing up for a 

free 30-day trial of Office 365 by visiting www.Office365.com.   

At a high level, here is some of what Office Live Small Business customers gain with Office 365 for professionals 

and small businesses: 

 

Get More with Microsoft Office 365  

Free of advertising, 99.9% financially-backed uptime guarantee, services designed specifically for small 

organizations, affordable subscription at $6 per user per month, available in more countries 

Email Manage email the way you want with more storage (25GB), larger 

messages (25MB), multiple email aliases per user, and Outlook Web 

App - a rich-web-based version of Microsoft Office Outlook  

                                                      
1
 Access from mobile devices depends on carrier network availability 

http://www.office365.com/
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Contacts View a Global Address List including all of your users, globally 

accessible distribution groups, and external contacts 

Calendar Manage your busy day with a calendar that is fully compatible with 

Outlook, automatically synched across your devices, and enables you to 

view your colleagues' availability, share your calendar with others and 

view calendars side-by-side 

IM, Audio/Video Calling and Web 

Conferencing 

Connect with coworkers and customers to share presentations internally 

and externally, conduct meetings online, click-to-connect from within 

Microsoft Office applications, PC-to-PC calling, and instant messaging 

Team Sites and Document 

Management 

Manage your important documents with more storage (10GB+500MB 

per user), better collaboration capabilities, document co-authoring, 

enhanced mobile access, high fidelity document viewing, and business-

class data security 

Public-facing website Market your organization through a simple public-facing website with 

more storage to build your site, simple site design tools, and website 

hosting using  your custom domain or a free 3rd-level domain 

 

See Appendix A: Service Comparison for a more detailed 

comparison.  
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Appendix A: Service Comparison 

 

To better understand how Office 365 can help your business, we’ve created the detailed table below so you can 

see how Office 365 for professionals and small businesses and Office Live Small Business compare.  If you want 

more information on Office 365, visit www.Office365.com or read the Office 365 for professionals and small 

businesses Service Description available through the Microsoft Download Center. 

 

 

Key Service Features 

Ad free, financially-backed 99.9% uptime guarantee, affordable subscription, designed for businesses 

Office Live Small Business Office 365 

Free with optional paid add-ons available $6 per month per user 

Advertising Supported Advertising Free 

Anti-virus and anti-spam solutions designed for consumers Anti-virus and anti-spam solutions designed for businesses 

Custom email and website domain support Custom email and website domain support 

Currently available in 8 countries Currently available in 38 countries 

Free 4th-level domain [yourcustom.web.smallbusiness.com] Free 3rd-level domain [yourcustom.onmicrosoft.com] 

24-7 Microsoft support agent moderated forums  24-7 Microsoft support agent moderated forums 

Telephone support for billing questions and email for technical 

questions 
Telephone and email support for billing questions 

No commitment No commitment with flexible month-to-month billing 

Windows Live Mail designed for consumers* Exchange Online designed for businesses* 

 Virtual Support Agent 

  Microsoft Office Web Apps 

  Financially-backed 99.9% uptime guarantee 

  
Business-class reliability with disaster recovery capabilities and 

data centers in multiple locations 

  
Included Office desktop set-up software  to connect your 

Microsoft Office software to Office 365 

  
Hosted Access Databases, publishable to your SharePoint Online 

Team Site 

 
Admin capabilities to enforce passwords on connected mobile 

devices 

*Windows Live Mail (Hotmail) is the familiar email, contacts and calendar offering designed specifically for consumer needs.  

Exchange Online is Microsoft’s solution designed for professional needs.  Some of the key features you get with Exchange Online 

and Office 365 include:  

 25GB of email storage per user 

 25MB email message/attachment size limit 

 Microsoft Outlook Web App - a web-based version of Microsoft Outlook 

http://www.office365.com/
http://www.microsoft.com/downloads/en/details.aspx?FamilyID=fe24f4c8-c4f7-48f5-9b75-8a1bb6af9e32
http://www.microsoft.com/downloads/en/details.aspx?FamilyID=fe24f4c8-c4f7-48f5-9b75-8a1bb6af9e32
http://www.microsoft.com/downloads/en/details.aspx?FamilyID=fe24f4c8-c4f7-48f5-9b75-8a1bb6af9e32
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 Multiple email aliases per user 

 Resource mailboxes to reserve and schedule shared resources 

 Recover deleted items (even in the deleted folder) for 14 days 

 Global Address List (GAL); a central directory for both internal and external contact information 

 Distribution groups accessible through your GAL 

 Share rich calendar information with everyone within your organization and other Office 365 customers 

 Fully compatible with Microsoft Outlook 

 View colleague's availability and compare calendars side-by-side in Outlook 

 Exchange control panel to manage users, groups, mailboxes  

 Remote device wipe in case you ever lose a mobile device 

 

IM, Audio/Video Calling and Web Conferencing 

Share presentations, rich presence information, click-to-connect from within Office applications 

None Lync Online 

  View colleague's presence status 

  Rich presence with click-to-communicate technology 

  Multi-party instant messaging 

  Multi-party PC-to-PC calling 

  Join online meetings from anywhere 

  
Share presentations on your screen with external clients or 

partners 

  

Team Sites and Document Management 

More storage, more collaboration capabilities, document co-authoring, professional-level data security 

Business Applications & Contact Manager SharePoint Online 

50MB per user 10GB + 500MB per user  

Contact Manager to organize your customers, business 

relations, sales opportunities, and product information 

Hosted Access Databases, publishable to your SharePoint Online 

Team Sites 

Password protected Password protected 

Built-in check-in and check-out capabilities Built-in check-in and check-out capabilities 

Revision tracking Revision tracking with detailed document revision histories 

Customizable Outlook alerts to notify you of changes Customizable Outlook alerts to notify you of changes 

  Mobile document access 

  Real-time document co-authoring 

  Offline access (with Microsoft SharePoint Workspace) 

  Robust  team site tools and templates 

  Professional-level data security 

  

Public-facing Website 

More storage to build your site, simple site design tools, free 3rd-level domain 

Site Designer SharePoint Online Site Designer 

500MB 10GB + 500MB per user (shared with Team Site space) 
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  * Through CSS (Style Sheets) and HTML, much of the built-in design functionality that Office Live Small Business Site 

Designer offered can be replicated in Office 365’s SharePoint Online Site Designer.  

Free 4th-level domain [yourdomain.web.smallbusiness.com] Free 3rd-level domain [yourdomain.sharepoint.com] 

Built-in Design Tools for Small Businesses Built-in Design Tools for Small Businesses 

Contact Us Contact Us 

HTML HTML 

Map & Directions Map & Directions 

Style Sheets Style Sheets 

Slide show Slide show 

Video Video 

PayPal PayPal 

Stock list Stock list 

Weather Weather 

Site Information Site Information 

Custom Navigation Custom Navigation 

Custom Header Custom Header 

Custom Footer Custom Footer 

Bring Your Own Site Code   

Built-in Blog Module*  * 

Built-in Analytics*  * 

Event Calendar Publishing*  * 

Form Designer*  * 

List Publisher   

Integrated  'subscribe to newsletter'   

Contact Manager  
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Appendix B: Office 365 System Requirements 

 

Recommended Operating Systems and Software 

For the best experience with Office 365, we recommend the following operating systems and software: 

• Windows 7  

• Office 2010 or Office Professional Plus  

• Internet Explorer 8 

• Lync 2010 (included in Office 365 Plan P1) 

• Office desktop set up (an installable piece of software included in Office 365 Plan P1) 

 

Operating Systems and Software Not Supported 

The following operating systems and software versions are not supported when using Office 365:  

• Windows Server® 2003 

• Microsoft Office Outlook 2003  

• Microsoft Internet Explorer 6 

• Microsoft Office Communicator 2007  

 

Office 365 works effectively with many combinations of browsers, operating systems, and supporting software, but 

table below shows the software supported by Office 365. 

Software supported by Office 365 

Software Supported Version 

Operating systems Windows 7  

Windows Vista® SP2  

Windows Media Center  

Windows XP Home 

Windows XP SP3 with RPC over HTTP patch  

Mac OS X 10.4 (Tiger), 10.5 (Leopard), 10.6 (Snow Leopard) 

System software Microsoft .NET Framework 3.0 (for Windows XP) 

Java client 1.4.2 (for Macintosh OS X)* 

Office Clients  Microsoft Office Professional Plus 

Office 2010 

Office 2007 SP2 

Office for Mac 2011  

Microsoft Entourage® 2008 Web Services Edition  
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For the most recent information about software requirements, see Software requirements for Office 365 at 

http://onlinehelp.microsoft.com/en-us/office365-smallbusinesses/ff652564.aspx. 

 

.NET 2.0 or later  

Lync 2010 (included in Office 365 Plan P1) 

Mac Messenger 9 

Mobility  For Exchange Online: Microsoft Windows Mobile® and Windows 

Phone, Nokia E and N series devices, Android, Palm devices, 

Apple iPhone, and iPad, Blackberry*  

For SharePoint Online: Windows Mobile 6.5.x, Nokia E series and 

N series devices, Android, Apple iPhone 2.0+  

*Blackberry operates using the Blackberry Internet Service (BIS). 

Blackberry Exchange Services (BES) is not supported in Office 365 

Plan P1 

Client applications Office desktop set up 

Browser software—Microsoft Online Portal and 

Office Web Apps 

Internet Explorer 7 or later 

Mozilla Firefox 3.x 

Apple Safari 3.x 

Browser software  

Outlook Web App 

Internet Explorer 7 or later 

Firefox 3 or higher 

Safari 3 or higher on Macintosh OS X 10.5 

Chrome 3 and later versions 

Outlook Web App also has a light version that supports a 

reduced set of features across almost any browser 

http://onlinehelp.microsoft.com/en-us/office365-smallbusinesses/ff652564.aspx
http://onlinehelp.microsoft.com/en-us/office365-smallbusinesses/ff652564.aspx

